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Microsoft PowerPoint 2013 Keyboard shortcuts

Online Help 

Keyboard Shortcuts for using the Help window

The Help window provides access to all Office Help content. The Help window displays topics and other Help content

In the Help Window

Press To do this Press To do this

F1 Open the Help window ENTER Perform the action for the selected Show 
All, Hide All, hidden text, or hyperlink.

ALT+F4 Close the Help window. ALT+LEFT ARROW 
or BACKSPACE

Move back to the previous Help topic (Back 
button).

ALT+TAB Switch between the Help 
window and the active 
program.

ALT+RIGHT ARROW Move forward to the next Help topic 
(Forward button).

ALT+HOME Go back to PowerPoint Help 
and How-to table of contents.

UP ARROW, DOWN 
ARROW

Scroll small amounts up or down, 
respectively, within the currently displayed 
Help topic.

TAB Select the next item in the 
Help window.

PAGE UP, PAGE 
DOWN

Scroll small amounts up or down, 
respectively, within the currently displayed 
Help topic.

SHIFT+TAB Select the previous item in 
the Help window.

SHIFT+F10 Display a menu of commands for the Help 
window. This requires that the Help window 
have the active focus (click in the Help 
window).

ENTER Perform the action for the 
selected item.

ESC Stop the last action (Stop button).

TAB Select the next hidden text 
or hyperlink, including Show 
All or Hide All at the top of a 
Help topic

CTRL+P Print the current Help topic.

SHIFT+TAB Select the previous hidden 
text or hyperlink.

NOTE:  If the cursor is not in the current Help topic, press F6 and then press CTRL+P
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Microsoft Office basics

Display and use windows

Press To do this Press To do this

ALT+TAB Switch to the next window SHIFT+F6 Move to a pane from another pane in 
the program window (counterclockwise 
direction)

ALT+SHIFT+TAB + 
TAB

Switch to the previous 
window

CTRL+F6 When more than one PowerPoint window 
is open, switch to the next PowerPoint 
window.

CTRL+W or 
CTRL+F4

Close the active window. CTRL+SHIFT+F6 Switch to the previous PowerPoint window.

CTRL+F5 Broadcast the open 
presentation to a remote 
audience using the 
PowerPoint web application

PRINT SCREEN Copy a picture of the screen to the 
Clipboard.

F6 Move to the next task pane 
from another pane in the 
program window (clockwise 
direction). You may need to 
press F6 more than once.

 NOTE   If pressing F6 does 
not display the task pane that 
you want, press ALT to put 
the focus on the ribbon, and 
then press CTRL+TAB to move 
to the task pane.

ALT+PRINT SCREEN Copy a picture of the selected window to 
the Clipboard.

Change or resize the font

Press To do this Press To do this

CTRL+SHIFT+F Change the font CTRL+SHIFT+> Increase the font size of the selected text.
CTRL+SHIFT+P Change the font size. CTRL+SHIFT+< Move to the beginning of a text box

Move around in text or cells

Press To do this Press To do this

LEFT ARROW Move one character to the 
left

HOME Move to the beginning of a line

RIGHT ARROW Move one character to the 
right

CTRL+UP ARROW Move up one paragraph

UP ARROW Move one line up CTRL+DOWN 
ARROW

Move down one paragraph

DOWN ARROW Move one line down CTRL+END Move to the end of a text box
CTRL+LEFT ARROW Move one word to the left CTRL+HOME Move to the beginning of a text box
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CTRL+RIGHT 
ARROW

Move one word to the right CTRL+ENTER In PowerPoint, move to the next title 
or body text placeholder. If it is the last 
placeholder on a slide, this will insert a 
new slide with the same slide layout as the 
original slide

END Move to the end of a line SHIFT+F4 Repeat the last Find action

Find and replace

Press To do this Press To do this

CTRL+F Open the Find dialog box. SHIFT+F4 Repeat the last Find action.
CTRL+H Open the Replace dialog box.

Move around in and work in tables

Press To do this Press To do this

TAB Move to the next cell. CTRL+TAB Insert a tab in a cell.
SHIFT+TAB Move to the preceding cell. ENTER Start a new paragraph.
DOWN ARROW Move to the next row. TAB in the bottom 

right table cell.
Add a new row at the bottom of the table.

UP ARROW Move to the preceding row.

Access and use task panes

Press To do this Press To do this

F6 Move to a task pane from 
another pane in the program 
window. (You may need to 
press F6 more than once.)

HOME, END When a menu or submenu is visible, select 
the first or last command, respectively, on 
the menu or submenu.

TAB, SHIFT+TAB When a task pane is active, 
select the next or previous 
option in the task pane, 
respectively.

PAGE UP, PAGE 
DOWN

Scroll up or down in the selected gallery 
list, respectively.

CTRL+DOWN 
ARROW

Display the full set of 
commands on the task pane 
menu.

HOME, END Move to the top or bottom of the selected 
gallery list, respectively.

DOWN ARROW or 
UP ARROW

Move among choices on a 
selected submenu; move 
among certain options in a 
group of options in a dialog 
box.

CTRL+SPACEBAR, C Close a task pane.

SPACEBAR or 
ENTER

Open the selected menu, or 
perform the action assigned 
to the selected button.

ALT+H, F, O Open the Clipboard.

SHIFT+F10 Open a shortcut menu; open 
a drop-down menu for the 
selected gallery item.
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Resize a task pane
1. In the task pane, press CTRL+SPACEBAR to display a menu of additional commands.

2. Use the DOWN ARROW key to select the Size command, and then press ENTER.

3. Use the arrow keys to resize the task pane. Use CTRL+ the arrow keys to resize one pixel at a time.

NOTE: When you finish resizing, press ESC.

Use dialog boxes

Press To do this Press To do this

TAB Move to the next option or 
option group.

UP ARROW, DOWN 
ARROW

Move between options in an open drop-
down list, or between options in a group of 
options.

SHIFT+TAB Move to the previous option 
or option group.

SPACEBAR Perform the action assigned to the selected 
button; select or clear the selected check 
box.

DOWN ARROW Switch to the next tab in 
a dialog box. (A tab must 
already be selected in an open 
dialog box)

The letter 
underlined in an 
option

Select an option; select or clear a check 
box.

UP ARROW Switch to the previous tab 
in a dialog box. (A tab must 
already be selected in an open 
dialog box)

ENTER Perform the action assigned to a default 
button in a dialog box.

DOWN ARROW, 
ALT+DOWN 
ARROW

Open a selected drop-down 
list.

ESC Close a selected drop-down list; cancel a 
command and close a dialog box.

First letter of an 
option in a drop-
down list

Open the list if it is closed and 
move to an option in the list.

Use edit boxes within dialog boxes

An edit box is a blank box in which you type or paste an entry, such as your user name or the path of a folder.

Press To do this Press To do this

HOME Move to the beginning of the 
entry.

SHIFT+RIGHT 
ARROW

Select or cancel selection one character to 
the right.

END Move to the end of the entry. CTRL+SHIFT+LEFT 
ARROW

Select or cancel selection one word to the 
left.

LEFT ARROW, 
RIGHT ARROW

Move one character to the left 
or right, respectively.

CTRL+SHIFT+RIGHT 
ARROW

Select or cancel selection one word to the 
right.

CTRL+LEFT ARROW Move one word to the left. SHIFT+HOME Select from the cursor to the beginning of 
the entry.

CTRL+RIGHT 
ARROW

Move one word to the right. SHIFT+END Select from the cursor to the end of the 
entry.

SHIFT+LEFT 
ARROW

Select or cancel selection one 
character to the left.
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Use the Open and Save As dialog boxes

You can go back to using Ctrl+S and Ctrl+O to see the dialog boxes, by clicking File > Options > Save, and then checking 
the Don’t show the Backstage when opening or saving files box. You only have to set this option in one Office program 
for it to work in all Office programs.

Press To do this Press To do this

CTRL+F12 View the Open dialog box SHIFT+F10 Display a shortcut menu for a selected 
item, such as a folder or file.

F12 View the Save As dialog box TAB Move forward through options.
ENTER Open the selected folder or 

file.
SHIFT+TAB Move back through options.

BACKSPACE Open the folder one level 
above the selected folder.

F4 or ALT+I Open the Look in list.

DELETE Delete the selected folder or 
file.

F5 Refresh the file list.

Use Open and Save As in the Backstage

You can go back to using the dialog boxes by clicking File > Options > Save, and then checking the Don’t show the 
Backstage when opening or saving files box. You only have to set this option in one Office program for it to work in all 
Office programs.

Press To do this Press To do this

CTRL+O View Open in the Backstage. ALT+F+S View Save As in the Backstage (after giving 
the file a name and location).

CTRL+S View Save As in the Backstage. ESC Return to your Office file.
CTRL+S Continue saving an Office file 

(after giving the file a name 
and location).

Navigating the ribbon

Access any command with a few keystrokes
1. Press ALT.

The KeyTips are displayed over each feature that is available in the current view.

2. Press the letter shown in the KeyTip over the feature that you want to use.

3. Depending on which letter you press, you may be shown additional KeyTips. For example, if the Home tab is 
active and you press N, the Insert tab is displayed, along with the KeyTips for the groups on that tab.

4. Continue pressing letters until you press the letter of the command or control that you want to use. In some 
cases, you must first press the letter of the group that contains the command. For example, if the Home tab is 
active, press ALT+H, F, S will take you to the Size list box in the Font group.

 NOTE   To cancel the action that you are taking and hide the KeyTips, press ALT.
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Change the keyboard focus without using the mouse

Another way to use the keyboard to work with the ribbon is to move the focus among the tabs and commands until you 
find the feature that you want to use. The following table lists some ways to move the keyboard focus without using the 
mouse.

Press To do this Press To do this

ALT or F10. Press 
either of these keys 
again to move back 
to the document 
and cancel the 
access keys.

Select the active tab of the 
ribbon and activate the access 
keys.

DOWN ARROW, 
UP ARROW, LEFT 
ARROW, RIGHT 
ARROW

Move down, up, left, or right among the 
items on the ribbon, respectively.

F10 to select the 
active tab, and 
then LEFT ARROW, 
RIGHT ARROW

Move left or right to 
another tab of the ribbon, 
respectively.

SPACE BAR or 
ENTER

Activate the selected command or control 
on the ribbon.

CTRL+F1 Hide or show the ribbon. SPACE BAR or 
ENTER

Open the selected menu or gallery on the 
ribbon.

SHIFT+F10 Display the shortcut menu for 
the selected command.

ENTER Activate a command or control on the 
ribbon so you can modify a value.

F6 Move the focus to select each 
of the following areas of the 
window:

•	 Active tab of the ribbon

•	 Any open task panes

•	 Your document

ENTER Finish modifying a value in a control on the 
ribbon, and move the focus back to the 
document.

TAB, SHIFT+TAB Move the focus to each 
command on the ribbon, 
forward or backward 
respectively.

F1 Get help on the selected command or 
control on the ribbon. (If no Help topic is 
associated with the selected command, a 
general Help topic about the program is 
shown instead.)

Common tasks in PowerPoint

Move between panes

Press To do this Press To do this

F6 Move clockwise among panes 
in Normal view.

CTRL+SHIFT+TAB Switch between Slides and Outline tabs in 
the Outline and Slides pane in Normal view

SHIFT+F6 Move counterclockwise 
among panes in Normal view.

Work in an outline

Press To do this Press To do this

ALT+SHIFT+LEFT 
ARROW

Promote a paragraph. ALT+SHIFT+1 Show heading level 1.
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ALT+SHIFT+RIGHT 
ARROW

Demote a paragraph. ALT+SHIFT+PLUS 
SIGN

Expand text below a heading.

ALT+SHIFT+UP 
ARROW

Move selected paragraphs up. ALT+SHIFT+MINUS 
SIGN

Collapse text below a heading.

ALT+SHIFT+DOWN 
ARROW

Move selected paragraphs 
down.

Work with shapes, pictures, boxes, objects, and WordArt
Insert a shape

1. Press and release ALT, then N, then S, then H to select Shapes.

2. Use the arrow keys to move through the categories of shapes, and select the shape that you want.

3. Press CTRL+ENTER to insert the shape that you selected.
Insert a text box

1. Press and release ALT, then N, and then X.

2. Press CTRL+ENTER to insert the text box.
Insert an object

1. Press and release ALT, then N, then J to select Object.

2. Use the arrow keys to move through the objects.

3. Press CTRL+ENTER to insert the object that you want.
Insert WordArt

1. Press and release ALT, then N, then W to select WordArt.

2. Use the arrow keys to select the WordArt style that you want, and then press ENTER.

3. Type the text that you want.
Select a shape

NOTE   If your cursor is within text, press ESC.

•	 To select a single shape, press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the 
objects until sizing handles appear on the object that you want to select.

•	 To select multiple items, use the selection pane.
Group or ungroup shapes, pictures, and WordArt objects

•	 To group shapes, pictures, or WordArt objects, select the items that you want to group, and then press CTRL+G.

•	 To ungroup a group, select the group, and then press CTRL+SHIFT+G.
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Show or hide a grid or guides

Press To do this Press To do this

SHIFT+F9 Show or hide the grid. ALT+F9 Show or hide guides.

Copy the attributes of a shape

1. Select the shape with the attributes that you want to copy.

 NOTE   If you select a shape with text, you copy the look and style of the text in addition to the attributes of the shape.

2. Press CTRL+SHIFT+C to copy the object attributes.

3. Press the TAB key or SHIFT+TAB to select the object that you want to copy the attributes to.

4. Press CTRL+SHIFT+V.

Select text and objects

Press To do this Press To do this

SHIFT+RIGHT 
ARROW

Select one character to the 
right.

ESC Select an object (when the text inside the 
object is selected).

SHIFT+LEFT ARROW Select one character to the 
left.

TAB or SHIFT+TAB 
until the object you 
want is selected

Select another object (when one object is 
selected).

CTRL+SHIFT+RIGHT 
ARROW

Select to the end of a word. ENTER Select text within an object (with an object 
selected).

CTRL+SHIFT+LEFT 
ARROW

Select to the beginning of a 
word.

CTRL+A (on the 
Slides tab)

Select all objects.

SHIFT+UP ARROW Select one line up (with the 
cursor at the beginning of a 
line).

CTRL+A (in Slide 
Sorter view)

CTRL+A (in Slide Sorter view)

SHIFT+DOWN 
ARROW

Select one line down (with 
the cursor at the beginning of 
a line).

CTRL+A (on the 
Outline tab)

Select all text.

Delete and copy text and objects

Press To do this Press To do this

BACKSPACE Delete one character to the 
left.

CTRL+V Paste cut or copied object or text.

CTRL+BACKSPACE Delete one word to the left. CTRL+Z Undo the last action.
DELETE Delete one character to the 

right.
CTRL+Y Redo the last action.

CTRL+DELETE Delete one word to the right.

 NOTE   The cursor must be 
between words to do this.

CTRL+SHIFT+C Copy formatting only.

CTRL+X Cut selected object or text. CTRL+SHIFT+V Paste formatting only.
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CTRL+C Copy selected object or text. CTRL+ALT+V Open Paste Special dialog box.

Move around in text

Press To do this Press To do this

LEFT ARROW Move one character to the 
left.

HOME Move to the beginning of a line.

RIGHT ARROW Move one character to the 
right.

CTRL+UP ARROW Move up one paragraph.

UP ARROW Move one line up. CTRL+DOWN 
ARROW

Move down one paragraph.

DOWN ARROW Move one line down. CTRL+END Move to the end of a text box.
CTRL+LEFT ARROW Move one word to the left. CTRL+HOME Move to the beginning of a text box.
CTRL+RIGHT 
ARROW

Move one word to the right. CTRL+ENTER Move to the next title or body text 
placeholder. If it is the last placeholder on 
a slide, this will insert a new slide with the 
same slide layout as the original slide.

END Move to the end of a line. SHIFT+F4 Move to repeat the last Find action.

Move around in and work on tables

Press To do this Press To do this

TAB Move to the next cell. CTRL+TAB Insert a tab in a cell.
SHIFT+TAB Move to the preceding cell. ENTER Start a new paragraph.
DOWN ARROW Move to the next row. TAB in the bottom 

right table cell.
Add a new row at the bottom of the table.

UP ARROW Move to the preceding row.

Edit a linked or embedded object
1. Press TAB OR SHIFT+TAB to select the object that you want.

2. Press SHIFT+F10 for the shortcut menu. 

3. Use the DOWN ARROW until Worksheet Object is selected, press RIGHT ARROW to select Edit, and press 
ENTER.

 NOTE:   The name of the command in the shortcut menu depends on the type of embedded or linked object. For 
example, an embedded Microsoft Office Excel worksheet has the command Worksheet Object, whereas an embedded 
Microsoft Office Visio Drawing has the command Visio Object.

Format and align characters and paragraphs

Change or resize the font

NOTE:   You must first select the text that you wish to change to use these keyboard shortcuts.

Press To do this Press To do this

CTRL+SHIFT+F Open the Font dialog box to 
change the font.

CTRL+SHIFT+< Decrease the font size.

CTRL+SHIFT+> Increase the font size.
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Apply character formats

Press To do this Press To do this

CTRL+T Open the Font dialog box 
to change the formatting of 
characters.

CTRL+EQUAL SIGN Apply subscript formatting (automatic 
spacing).

SHIFT+F3 Change the case of letters 
between sentence, lowercase, 
or uppercase.

CTRL+SHIFT+PLUS 
SIGN

Apply superscript formatting (automatic 
spacing).

CTRL+B Apply bold formatting. CTRL+SPACEBAR Remove manual character formatting, such 
as subscript and superscript.

CTRL+U Apply an underline. CTRL+K Insert a hyperlink.
CTRL+I Apply italic formatting.

Copy text formats

Press To do this Press To do this

CTRL+SHIFT+C Copy formats. CTRL+SHIFT+V Paste formats.

Align paragraphs

Press To do this Press To do this

CTRL+E Center a paragraph. CTRL+L Left align a paragraph.
CTRL+J Justify a paragraph. CTRL+R Right align a paragraph.

Run a presentation

Slideshow Shorcuts

Press To do this Press To do this

F5 Start a presentation from the 
beginning.

R Re-record slide narration and timing

N, ENTER, PAGE 
DOWN, RIGHT 
ARROW, DOWN 
ARROW, or 
SPACEBAR

Perform the next animation 
or advance to the next slide.

Press and hold 
Right and Left 
Mouse buttons for 
2 seconds

Return to the first slide.

P, PAGE UP, 
LEFT ARROW, 
UP ARROW, or 
BACKSPACE

Perform the previous 
animation or return to the 
previous slide.

CTRL+P Change the pointer to a pen.

number+ENTER Go to slide number. CTRL+A Change the pointer to an arrow.
B or PERIOD Display a blank black slide, 

or return to the presentation 
from a blank black slide.

CTRL+E Change the pointer to an eraser

W or COMMA Display a blank white slide, 
or return to the presentation 
from a blank white slide.

CTRL+M Show or hide ink markup
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S Stop or restart an automatic 
presentation.

CTRL+H Hide the pointer and navigation button 
immediately.

ESC or HYPHEN End a presentation. CTRL+S View the All Slides dialog box
E Erase on-screen annotations. CTRL+T View the computer task bar
H Go to the next slide, if the 

next slide is hidden.
SHIFT+F10 Display the shortcut menu.

T Set new timings while 
rehearsing.

TAB Go to the first or next hyperlink on a slide.

O Use original timings while 
rehearsing.

SHIFT+TAB Go to the last or previous hyperlink on a 
slide.

M Use mouse-click to advance 
while rehearsing.

ENTER while 
a hyperlink is 
selected

Perform the “mouse click” behavior of the 
selected hyperlink.

Media shortcuts during presentation

Press To do this Press To do this

ALT+Q Stop media playback ALT+Down Decrease the sound volume
ALT+P Toggle between play and 

pause
ALT+SHIFT+PAGE 
DOWN

Seek forward

ALT+END Go to the next bookmark ALT+SHIFT+PAGE 
UP

Seek backward

ALT+HOME Go to the previous bookmark ALT+U Mute the sound
ALT+Up Increase the sound volume
TIP:  You can press F1 during your presentation to see a list of controls.

Browse Web presentations

The following keys are for viewing your Web presentation in Microsoft Internet Explorer 4.0 or later.

Press To do this Press To do this

TAB Move forward through 
the hyperlinks in a Web 
presentation, the Address bar, 
and the Links bar

ENTER Perform the “mouse click” behavior of the 
selected hyperlink.

SHIFT Move back through the 
hyperlinks in a Web 
presentation, the Address bar, 
and the Links bar.

SPACEBAR Go to the next slide.
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Use the Selection pane feature

Use the following keyboard shortcuts in the Selection pane.

To launch the Selection pane, press Alt, then H, then S, then L, and then P.

Press To do this Press To do this

F6 Cycle the focus through the 
different panes.

SPACEBAR or 
ENTER

Select a focused item.

SHIFT+F10 Display the context menu. SHIFT+SPACEBAR or 
SHIFT+ENTER

Cancel selection of a focused item.

UP ARROW or 
DOWN ARROW

Move the focus to a single 
item or group.

CTRL+SHIFT+F Move a selected item forward.

LEFT ARROW Move the focus from an item 
in a group to its parent group.

CTRL+SHIFT+B Move a selected item backward.

RIGHT ARROW Move the focus from a group 
to the first item in that group.

CTRL+SHIFT+S Show or hide a focused item.

* (on numeric 
keypad only)

Expand a focused group and 
all its child groups.

F2 Rename a focused item.

+ (on numeric 
keypad only

Expand a focused group. TAB or SHIFT+TAB Switch the keyboard focus within the 
Selection pane between tree view and the 
Show All and Hide All buttons.

- (on numeric 
keypad only)

Collapse a focused group. ALT+SHIFT+1 Collapse all groups.

 NOTE   The focus must be in the tree view 
of the Selection pane to use this shortcut.

SHIFT+UP ARROW 
or SHIFT+DOWN 
ARROW

Move the focus to an item 
and select it.

ALT+SHIFT+9 Expand all groups

To assign custom keyboard shortcuts to menu items, recorded macros, and Visual Basic for Applications (VBA) code 
in PowerPoint, you must use a third-party add-in, such as Shortcut Manager for PowerPoint, which is available from 
OfficeOne Add-Ins for PowerPoint.

Keyboard shortcuts for use while delivering a presentation in PowerPoint 2013

You can use the following keyboard shortcuts while you run your presentation in full screen mode.

Slide show shortcuts

Press To do this Press To do this

N, ENTER, PAGE 
DOWN, RIGHT 
ARROW, DOWN 
ARROW, or 
SPACEBAR

Perform the next animation 
or advance to the next slide.

CTRL+P Change the pointer to a pen.

P, PAGE UP, 
LEFT ARROW, 
UP ARROW, or 
BACKSPACE

Perform the previous 
animation or return to the 
previous slide.

CTRL+A Change the pointer to an arrow.
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number+ENTER Go to slide number. CTRL+E Change the pointer to an eraser
B or PERIOD Display a blank black slide, 

or return to the presentation 
from a blank black slide.

CTRL+M Show or hide ink markup

W or COMMA Display a blank white slide, 
or return to the presentation 
from a blank white slide.

CTRL+H Hide the pointer and navigation button 
immediately.

S Stop or restart an automatic 
presentation.

CTRL+U Hide the pointer and navigation button in 
15 seconds.

ESC End a presentation. CTRL+S View the All Slides dialog box
E Erase on-screen annotations. CTRL+T View the computer task bar
H Go to the next slide, if the 

next slide is hidden.
SHIFT+F10 Display the shortcut menu.

T Set new timings while 
rehearsing.

TAB Go to the first or next hyperlink on a slide.

R Re-record slide narration and 
timing

SHIFT+TAB Go to the last or previous hyperlink on a 
slide.

Press and hold Left 
Mouse button for 
several seconds

Return to the first slide. ENTER while 
a hyperlink is 
selected

Perform the “mouse click” behavior of the 
selected hyperlink

Media shortcuts during presentation

 NOTE    These shortcuts work only for video imported from a file on your computer. They don’t work if you’re inserting 
online videos.

Press To do this Press To do this

ALT+Q Stop media playback ALT+Down Decrease the sound volume
ALT+P Toggle between play and 

pause
ALT+SHIFT+PAGE 
DOWN

Seek forward

ALT+END Go to the next bookmark ALT+SHIFT+PAGE 
UP

Seek backward

ALT+HOME Go to the previous bookmark ALT+U Mute the sound
ALT+Up Increase the sound volume
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